OpenEnterprise Alarm Printer Server Reference Guide (V2.83)
Contents

1 Alarm Printer Server ................................................................................................................ 1
  1.1 Alarm Printer Server Overview ........................................................................................... 1
  1.2 Client-Server Application Architecture ................................................................................ 1
  1.3 Pre-Starting Server Components ........................................................................................ 1
  1.4 Auto Termination and the Alarm Printer Server .................................................................. 2
  1.5 User Interface ...................................................................................................................... 2
    1.5.1 Main Dialog ................................................................................................................... 2
    1.5.2 File Menu ...................................................................................................................... 3
    1.5.3 Edit Menu ...................................................................................................................... 3
    1.5.4 View Menu .................................................................................................................... 3
    1.5.5 Help Menu .................................................................................................................... 3
    1.5.6 Toolbar .......................................................................................................................... 3
    1.5.7 Databases List .............................................................................................................. 3
    1.5.8 Number of Server Objects ............................................................................................ 3
    1.5.9 Number of Subscription Objects ................................................................................... 3
    1.5.10 Number of Database Connections ............................................................................ 3
    1.5.11 Number of Current Alarms ........................................................................................ 3
    1.5.12 Total Alarms Processed ............................................................................................ 4
    1.5.13 Number of OnAlarm Messages Returned .................................................................. 4
    1.5.14 Reset Button .............................................................................................................. 4
    1.5.15 Properties Dialog ....................................................................................................... 4
      1.5.15.1 General Tab .......................................................................................................... 4
        1.5.15.1.1 Show System Tray Icon .................................................................................. 5
        1.5.15.1.2 Show Window ................................................................................................. 5
        1.5.15.1.3 Minimized ........................................................................................................ 5
        1.5.15.1.4 Hide on Minimize ............................................................................................ 5
        1.5.15.1.5 OK Button ....................................................................................................... 5
        1.5.15.1.6 Cancel Button ................................................................................................. 5
      1.5.15.2 Databases Tab ...................................................................................................... 5
        1.5.15.2.1 Preconnect Databases List ............................................................................. 6
        1.5.15.2.2 Add Database Button ..................................................................................... 6
        1.5.15.2.3 Remove Button ............................................................................................... 6
        1.5.15.2.4 Add Database Dialog ...................................................................................... 6
          1.5.15.2.4.1 New Database .......................................................................................... 6
          1.5.15.2.4.2 OK Button ................................................................................................. 6
          1.5.15.2.4.3 New Database Cancel Button .................................................................. 6

2 Index ......................................................................................................................................... 7
1 Alarm Printer Server

1.1 Alarm Printer Server Overview

The Alarm Printer Server is a software component that provides data requested by the Alarm Printer View. The Alarm Printer Server 'serves' the Alarm Printer Client with data from the database. Unlike most other OpenEnterprise Views, the Alarm Printer View (and its server component) can and should be run on the OpenEnterprise Server machine, although it can be run on a Workstation.

Like all of the Client Server components, the Alarm Printer Server has its own User Interface (UI), which enables the user to specify and view the databases to which it is connected, and control the way the UI behaves. When it is running, its icon is visible in the System Tray at the bottom right of the Windows Desktop. To display the UI, double click on this icon in the System Tray.

1.2 Client-Server Application Architecture

Most OpenEnterprise View components (e.g. Alarm View, Alarm Printer View, Trend View, OEGraphics View, Notes View) have what is known as three-tier Client-Server architecture. Each of the components listed above is a Client, which uses one or more Server components to provide them with the data that they request. This data is then displayed by the Client to the user. In turn, the Server component requests the data from what is usually a remote OpenEnterprise data source (Database Management System) running on an OpenEnterprise server. The Server component, is therefore a direct client of the OpenEnterprise database, but a Server of the OpenEnterprise View component (hence the term "three-tier"). Both Client and Server components must run on the same workstation, but the database usually runs on another machine.

1.3 Pre-Starting Server Components

All Server components are started automatically as a background process when a Client component starts up. They then close when the Client closes, except for the OPC and HDA Servers, which remain open by default. However, this can cause problems when Client components are being opened and closed rapidly. It is therefore recommended that Server components be started before any Client components begin requesting data from them. Obviously, if a Client component is not required, then the Server component is not required. The following are the Server components that should be started on an OpenEnterprise workstation before any of their 'Clients' begin running:

- The Bristol OPC Server (Clients = OEGraphics and Trend View)
- The Bristol HDA Server (Client = Trend View)
- The Alarm Server (Clients = Alarm View, Alarm Banner)
- The Alarm Printer Server (Client = Alarm Printer View)
- The Notes Server (Client = Notes View)

These components reside in the OpenEnterprise bin directory (by default C:\Program Files\Bristol\OpenEnterprise\bin). They are executables, and may be started in any of the ways that an executable file is started (e.g. double clicking, batch file, Startup menu).
1.4 Auto Termination and the Alarm Printer Server

By default, the Alarm Printer Server remains open when a calling Client closes. This behaviour can be changed using the OpenEnterprise Settings Editor. Open the Settings Editor, and find the OpenEnterprise\Tasks\AlarmPrinterServer key. Then look for a value on this key named AutoTerminate. If one is not there already, create one, and set the data to 1.

To set the Server back to normal behaviour (i.e. to remain open when the Client closes) set the value data back to 0 (zero).

1.5 User Interface

1.5.1 Main Dialog

This is the Main Dialog which provides the User Interface for the Alarm Printer Server. It enables the user to configure databases which the application can connect to and to view information regarding the number of server and client processes, the connections and the data retrieved from them.
1.5.2 File Menu

The File Menu provides an option to Exit the application. This will cause the application to close as a Windows process if the Alarm Printer Server is not currently supplying data to a client, but if it has a subscribing client, it will hide itself, but remain running as a process. The UI can be invoked again by double clicking on its icon in the System Tray.

1.5.3 Edit Menu

The Edit Menu provides an option to open the Properties dialog, which enables the user to configure pre-connect databases and the way that the UI behaves.

1.5.4 View Menu

There are two options available from this menu:

1. **Toolbar** - when checked, the toolbar is visible under the Menu bar.
2. **Status Bar** - when checked, the Status Bar is visible at the bottom of the Main Dialog window. It displays information on the current status of the Alarm Printer Server.

1.5.5 Help Menu

This provides an option to open the About dialog, which provides information on the version and build of OpenEnterprise being used and contact information.

1.5.6 Toolbar

This contains two icons:

- Properties icon - selection opens the Alarm Printer Server Properties dialog.
- About icon - selection opens the About dialog, which provides information on the version and build of OpenEnterprise being used and contact information.

1.5.7 Databases List

Successful or failed database connections are displayed here.

1.5.8 Number of Server Objects

OpenEnterprise is based on the Component Object Model (COM) method of programming. Each Alarm Printer Client creates an Alarm Client Server COM object, which enables it to talk to the Alarm Printer Server. This field displays the number of Alarm Client Server COM objects currently running. Due to the internal architecture of the Alarm Printer Server, there should only ever be a single Server object.

1.5.9 Number of Subscription Objects

This is the number of Alarm Printer Clients requesting data from the Alarm Printer Server.

1.5.10 Number of Database Connections

The number of databases to which the Alarm Printer Server is configured to connect on startup, plus any other connection which may have been requested by a client (an Alarm Printer View).
1.5.11    Number of Current Alarms

The Alarm Printer Client queries the EventLog table for alarms. The EventLog table contains the most recent 100 alarms, plus an entry for use as a message. Since this table never holds more than 101 entries, this should be the number displayed here unless the Alarm Printer Server is connected to multiple databases, in which case this number (101) will be multiplied by the number of database connections.

1.5.12    Total Alarms Processed

This is the total number of alarms processed by the Alarm Printer Server since it was started.

1.5.13    Number of OnAlarm Messages Returned

This is the number of alarm messages returned to the clients since the Alarm Printer Server was started.

1.5.14    Reset Button

This button resets the number of OnAlarm messages returned to clients to zero. The new number will begin increasing from the time of the reset.

1.5.15    Properties Dialog

The Edit Menu on the Main Dialog provides an option to open the Properties dialog, which enables the user to configure pre-connect databases and the way that the UI behaves. The Properties Dialog has two configuration tabs:

- General Tab
- Databases Tab

1.5.15.1    General Tab

This tab on the Property dialog enables the user to configure the way that the Alarm Printer Server User Interface behaves. Changes are implemented when the user selects the [OK] button at the bottom of the Properties dialog.

![Alarm Printer Server Properties dialog](image-url)
1.5.15.1.1 Show System Tray Icon

When checked, the Alarm Printer Server icon - ☑️ will be displayed in the System Tray when it is running. Double clicking on this icon in the System Tray will open the Alarm Printer Server's User Interface.

1.5.15.1.2 Show Window

When checked, the Alarm Printer Server's User Interface will be displayed on startup.

1.5.15.1.3 Minimized

When the Show Window box is checked, this option becomes enabled. If checked, on startup the Alarm Printer Server's User Interface will be displayed as a minimized icon on the Windows Task Bar.

1.5.15.1.4 Hide on Minimize

If checked, when the Alarm Printer Server's User Interface is minimized, it will also be hidden. If the Show System Tray Icon box and ShowWindow boxes are unchecked at the same time that this box is checked, then at startup the Alarm Printer Server's User Interface will not be available.

The interface may be restored by using the Settings Editor to manually change the ShowtrayIcon value on the OpenEnterprise\Tasks\AlarmPrinterServer key to 1. A restart will be necessary before the change takes effect.

1.5.15.1.5 OK Button

When this button is selected, changes made to any tab are saved, and the Property dialog is closed. Changes will be applied immediately.

1.5.15.1.6 Cancel Button

When this button is selected, the Property dialog is closed without saving any changes made on either tab.

1.5.15.2 Databases Tab

This tab on the Property dialog enables the user to configure databases that the Alarm Printer Server will attempt to connect to next time it is started.
1.5.15.2.1 Preconnect Databases List

This is the list of Preconnect Databases that have been configured for the Alarm Printer Server. When the Alarm Printer Server is started, it will attempt to connect with these databases, even though no Client may be requesting data at that time from them.

1.5.15.2.2 Add Database Button

When selected, the Add Database Dialog will appear, enabling the user to type in the name of a database to which connection is required.

1.5.15.2.3 Remove Button

This button will remove any selected databases from the Preconnect Databases list.

1.5.15.2.4 Add Database Dialog

This dialog enables a database to be defined for the Alarm Printer Server. The Alarm Printer Server will attempt connection with the defined databases on start-up.

![Add Database Dialog](image)

1.5.15.2.4.1 New Database

Type in the name of the new database here. A database name is comprised of `<ServerName>:<DataPortConnection>`. By default the DataPortConnection is defined as `rtrdb1` and has a TCP/IP port value of 11001 in the `<Drive>:\<WinFolder>\System32\Drivers\etc\Services` file.

1.5.15.2.4.2 OK Button

When this button is selected, the database defined in the New Database field will be added to the Predefined Databases list.

1.5.15.2.4.3 New Database Cancel Button

When selected, this button closes the Add New Database dialog without adding the name currently defined in the New Database field to the Predefined Databases list.
2 Index

A
Add Database Button......................................... 7
Add Database Dialog ......................................... 8
Alarm Printer Server Overview ......................... 3

C
Cancel Button..................................................... 7
Client-Server Application Architecture .......... 3
Connected Databases List................................. 5
Current Alarms................................................... 6
   Number ........................................................... 6

D
Database Connections....................................... 5
   Number ........................................................... 5
Databases Tab................................................... 7

E
Edit Menu ........................................................... 5

G
General Tab ....................................................... 6

H
Help Menu .......................................................... 5
Hide on Minimize................................................ 7

M
Main Dialog ........................................................ 4
Minimized ........................................................... 7

N
New Database.................................................... 8
New Database Cancel Button............................. 8

O
OK Button ........................................................... 7
OnAlarm Messages Returned ............................ 6
   Number ............................................................ 6

P
Preconnect Databases List............................... 7

R
Remove Button ................................................... 7
Reset Button ....................................................... 6

S
Server Objects .................................................... 5
   Number ............................................................ 5
Show System Tray Icon...................................... 6
Show Window ..................................................... 6
Subscription Objects......................................... 5
   Number ............................................................ 5

T
Total Alarms Processed...................................... 6

V
View Menu .......................................................... 5

New Database OK Button ..................................... 8
Number .............................................................. 5, 6
Current Alarms ................................................... 5
Database Connections ....................................... 6
OnAlarm Messages Returned ............................ 6
Server Objects ................................................... 5
Subscription Objects ......................................... 5
DISCLAIMER

Bristol, Inc., Bristol Babcock Ltd, Bristol Canada, BBI SA de CV and the Flow Computer Division, are wholly owned subsidiaries of Emerson Electric Co. doing business as Remote Automation Solutions (“RAS”), a division of Emerson Process Management. ROC, FloBoss, ROCLINK, Bristol, Bristol Babcock, ControlWave, TeleFlow and Helicoid are trademarks of RAS. AMS, PlantWeb and the PlantWeb logo are marks of Emerson Electric Co. The Emerson logo is a trademark and service mark of the Emerson Electric Co. All other marks are property of their respective owners.

The contents of this publication are presented for informational purposes only. While every effort has been made to ensure informational accuracy, they are not to be construed as warranties or guarantees, express or implied, regarding the products or services described herein or their use or applicability. RAS reserves the right to modify or improve the designs or specifications of such products at any time without notice. All sales are governed by RAS' terms and conditions which are available upon request. RAS does not assume responsibility for the selection, use or maintenance of any product. Responsibility for proper selection, use and maintenance of any RAS product remains solely with the purchaser and end-user.

Engineered and supported by:

Remote Automation Solutions,
Blackpole Road, Worcester, WR3 8YB, UK
Registered office: Meridian East, Leicester, LE19 1UX

Registered in England and Wales, Registration No. 00671801
VAT Reg No. GB 705 353 652